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2.1 What You Will Learn 
 
In this tutorial you will investigate a two-ray scenario 
that involves ground-reflected rays. You will examine 
the effect of wave polarization on the reflection 
characteristics. In this lesson you will use one 
of EM.Terrano's wizards and will learn how to use 
project variables. 

 

EM.Terrano Manual: 

 

EM.Terrano Tutorial Gateway: 

 

Download projects related to this tutorial lesson: 

 

2.2 Getting Started 

Start a new project with the following attributes.  

 

Starting Parameters 

Name EMTerrano_Lesson2 

Length Units Meters 

Frequency Units GHz 

Center Frequency 1GHz 

Bandwidth 0.1GHz 

 

2.3 Setting Up the Scene 

For this tutorial lesson, you will use a wizard to build the geometry of a simple communication link consisting 

of a transmitter and a grid of receivers. Click on the Basic Link Wizard  button of the Wizard Toolbar 
(Figure 1) or select the menu item Tools → Propagation Wizards → Basic Link.  
 

Tutorial Project: Examining A 
Polarimetric Propagation Channel 

 

Objective: In this project, the performance of a 
communication link in the presence of an infinite 
half-space ground and the effect of the antenna 
polarization are explored. 
  

Concepts/Features: 
 

• Point Object 

• Array Object 

• Point Radiators Set 

• Global Ground 

• Transmitter Set 

• Receiver Set 

• Antenna Polarization 

• Received Power Coverage Map 

• Ray Visualization  

 

Minimum Version Required: All versions 

 

http://www.emagtech.com/wiki/index.php/EM.Te

rrano 

http://www.emagtech.com/wiki/index.php/EM.Cu

be#EM.Terrano_Documentation  

http://www.emagtech.com/downloads/ProjectRep

o/EMTerrano_Lesson2.zip 

http://www.emagtech.com/wiki/index.php/EM.Terrano
http://www.emagtech.com/wiki/index.php/EM.Cube#EM.Picasso_Documentation
http://www.emagtech.com/downloads/ProjectRepo/EMTerrano_Lesson2.zip
http://www.emagtech.com/downloads/ProjectRepo/EMTerrano_Lesson2.zip
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Figure 1. EM.Terrano's wizard toolbar. 

 
A dialog opens up and asks for the total grid extents, transmitter location, transmitter height, receiver height 
and receiver spacing. Change the Grid Extents to 50m, change the transmitter height (Tx Height) and 
receiver height (Rx Height) both to 2m and change the receiver spacing (Rx Spacing) to 1m as shown in 
Figure 2.  
 

 

Figure 2. The Basic Link Wizard dialog. 

 
The wizard creates a single transmitter and a very dense grid of 51×51 receivers centered at the origin of 
coordinates (see Figure 3). Note that the wizard automatically creates all the point or array objects 
necessary for the definition of the transmitter and receiver sets. Later on, you will see that the scene created 
by the wizard is parameterized and you can easily modify the scene by changing the values of its 
parameters. 
 

 

Figure 3. The geometry of the basic link scene created by the wizard. 
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You can zoom to fit your structure into the screen using the keyboard shortcut Ctrl+E or by clicking the 

Zoom Extents  button of the View Toolbar. As you can see from the scene in Figure 3, the transmitter 

is collocated with one of the receivers since they have the same heights. 

 

 To move a transmitter or receiver to a new location, you need to move their associated point objects. 

 

There are different options for changing the location of your transmitter. Open the property dialog of the 
point object “TXP” associated with the transmitter. To do so, select the object's name (“TXP”) on the 
navigation tree, right-click the mouse and select Properties... from the contextual menu (Figure 4).  
 

 

 

Figure 4. Opening the property dialog of an object. 

 
As you can see from Figure 5, the X-, Y- and Z-coordinates of the point object “TXP” are set to "tx_x", 
"tx_y", and "tx_h", respectively. These are project variables, which were initiated automatically by the 
wizard. You can simply replace the numeric value of any object property and replace it with a variable name. 
For instance, to move the transmitter to location (-30m, 0, 0), you can simply replace “tx_x” in the TPX Point 
Properties dialog by -30 and click the OK button.  

 
 

http://www.emagtech.com/wiki/index.php/File:Fdtd_zoomextents.png
http://www.emagtech.com/wiki/index.php/File:Attention_icon.png
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Figure 5. The property dialog of the point object. 

 
 

All the project variables are list in Variables dialog. This dialog can be accessed by clicking 

the  button on the Simulate Toolbar (Figure 6) or selecting the menu item Simulate → 
Variables... or simply using the keyboard shortcut Ctrl+B.  
 
 
 
Figure 6. The Variables dialog button in the Simulate Toolbar  
 
 
 
Open variables dialog and examine the variables: 
 
 

Variable Name Purpose 

scene_size Total grid extents 

tx_x X-coordinate of transmitter (Tx) location 

tx_y Y-coordinate of transmitter (Tx) location 

tx_h Transmitter (Tx) height 

rx_h Receiver (Rx) height 

rx_spacing The receiver spacing 

rx_count Number of receiver array 

 
 
Now select/highlight the variable "tx_x" in the Variables dialog and click the Edit button to open the Edit 
Variable dialog (Figure 7). While you are in the Edit Variable dialog, enter -30 in the box labeled Definition 
for tx_x as shown in Figures 8. Click the OK buttons to return to the Variables dialog and check out the new 
value you just changed (Figure 9). From Figure 10 you can see that the point TXP moves to the left of the 
scene, and so does the rad ball, representing your transmitter. 
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Figure 7. EM.Terrano's Variables dialog. 

 

 

Figure 8. The Edit Variable dialog. 
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Figure 9. Changing variables value in the Variables dialog. 
 

 

Figure 10. The geometry of the link scene after moving the transmitter out of the receiver grid. 
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2.4 Running an SBR Ray Tracing Analysis 
 
At this time, you are ready to run a SBR simulation. Keep in mind that the default transmitter and receivers 

type are a vertically polarized (Z-directed) half-wave dipole antenna. Click the Run  button of the 
Simulate Toolbar to open up the Simulation Run dialog and select a simulation of the "Single-Frequency 
Analysis" type with “SBR Field Solver” as the simulation or solver type . At the end of the simulation, 
visualize the receiver power coverage map (Figure 11).  

 

 

Figure 11. The perspective view of the received power coverage map of the receiver set. 

 
 
EM.Cube's View Toolbar allows you to view the project workspace from different angles. Click the Top 

View  button or select the menu item View → Set View → Top View (Figure 12).  
 

 

 

Figure 12. EM.Terrano's View Toolbar. 
 

 
Figure 13 shows the top view of the received power coverage map of the receiver set. You can always go 

back to the perspective view by clicking the Perspective View  button of the View Toolbar or using 
the keyboard shortcut Home. 
 
 

http://www.emagtech.com/wiki/index.php/EM.Cube
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Figure 13. The top view of the received power coverage map of the receiver set. 
 

The coverage map clearly shows a pattern of concentric rings that result from constructive and destructive 
interference between the direct and reflected rays. 

 

2.5 Visualizing & Analyzing the Individual Rays 

 
In EM.Terrano, you can visualize all the 
rays received by each receiver along their 
entire path starting from the source location. 
To do that, right click on the Point 
Receivers item in the navigation tree and 
select Show Received Rays from the 
contextual menu as shown in Figure 14.  
 
 

Figure 14. Enabling the ray visualization 
from EM.Terranoôs navigation tree. 
 

 
In this case, you will see the two rays 
received by each receiver: the first is a 
direct ray from the transmitter to the 
receiver, and the second is a ray that is 
reflected off the ground. EM.Terrano allows 
you to analyze the individual rays. 

http://www.emagtech.com/wiki/index.php/EM.Terrano
http://www.emagtech.com/wiki/index.php/EM.Terrano
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Open the property dialog of your receiver set and select the receiver No. 1296 of the array, which is called 
"RX1_1296" (Figure 15). Visualize the two rays received by the receiver no. 1296 (see Figure 16). 

 

 

Figure 15. Selecting an individual receiver in the receiver set dialog. 

 

Now, click the Show Ray Data button of the Receiver Set dialog to open up the Ray Data dialog. You will 
see the two received rays listed along with their delay in nsec, phi and theta angles of arrival in degrees 
and power value in dBm (Figure 17). The computed received powers of the direct and ground-reflected 

rays are reported as -30.421dBm and -37.317dBm, respectively. The power of individual rays is 
calculated based on an isotropic receiver with unity gain. 
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Figure 16. Visualizing the rays received by the receiver no. 1296. 

 
 

 

Figure 17. Viewing the properties of individual rays in the ray data dialog. 
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The table below summarizes the important properties of the two rays: 

 
 
 
 
 
 
 
 
 
 
 
 

2.6 Verifying Your Simulation Results 
 

The ray diagram in Figure 18 shown below indicates that the direct and ground-reflected rays emanating 
from the transmitter and reaching the selected receiver. It identifies all the necessary distances and angles 
to calculate the characteristics of the receiver rays. 

 
Figure 18. The ray diagram of the line-of-sight link in the presence of the global ground. 

 

The delay and power of the direct ray are calculated as follows and agree well with the ray tables of both 
vertical and horizontal polarizations: 

ὶ Ὀ Ὤ Ὤ  ςυÍ 

ɝÔ
ὶ

ὧ

ςυ

σ ρπ
 ψσȢσσÎÓ 

 Direct Ray Ground-Reflected Ray 

Delay 83.333 ns 84.399 ns 

Theta Angle of Arrival 90° 80.91° 

Phi Angle of Arrival 0 0 

Ray Field Strength -10.198 dBV/m -17.094 dBV/m 

Ray Power -30.421 dBm -37.317 dBm 
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ὖ ὉὍὙὖ Ὃȟ ςπÌÏÇ
‗

τ“ὶ
ςωȢψψ π ςπÌÏÇ

πȢσ

τ“ ςυ
 σπȢυπψÄ"Í 

 
The ground-reflected ray first traverses a distance of ὶ from the transmitter to the specular point. Then, it 
undergoes reflection off the ground, and the reflected ray traverses a distance of ὶ from the specular point 

to the receiver. The total optical path length is ὶ ὶ. To find the specular point and the lengths ὶ and ὶ, 
note the geometric relation: 

Ὤ

Ὀ

Ὤ

Ὀ Ὀ
 

 
With Ὀ  19m and Ὤ  10m and Ὤ  1.5m, you find that: 

Ὀ
ὬὈ

Ὤ Ὤ
 ρςȢυÍ 

ὶ Ὤ Ὀ  ρςȢφυωÍ 

ὶ Ὤ Ὀ Ὀ   ρςȢφυωÍ 

ὶ ὶ ὶ  ςυȢσρψÍȢ 

The propagation delay of the reflected ray is therefore found to be: 

ɝÔ
ὶ ὶ

ὧ
 ψτȢσωÎÓȢ 

The reflected ray's Theta angle of arrival is the same as the incident angle: 

— — ÁÒÃÔÁÎ
Ὤ

Ὀ Ὀ
 ψπȢωρЈȢ 

 
The reflected ray received by the receiver can be thought of as if it was launched from the image of the 
transmitter in the ground (with respect to Z = 0). The reflection coefficient at the specular point depends on 
the wave polarization. In the case of a vertically polarized (Z-directed) transmitter antenna, we have the so-
called parallel polarization with the electric field parallel to the plane of incidence. In the case of a 
horizontally polarized (Y-directed) transmitter antenna, we have the so-called perpendicular polarization 
with the electric field normal to the plane of incidence. The reflection coefficients for both polarization case 
are given by: 

Ὑ Ὑ᷆
–ÃÏÓ— –ÃÏÓ—

–ÃÏÓ— –ÃÏÓ—
  

Ὑ Ὑ
–ÃÏÓ— –ÃÏÓ—

–ÃÏÓ— –ÃÏÓ—
 

where 

– –
‘

‐
 

 
The angles — and — are the incident and transmitted ray angles as shown in the figure, and the latter angle 
is calculated from Snell’s law: 

ὯÓÉÎ— ὯÓÉÎ— ȟ          Ὧ Ὧ ‘ ‐  

 

For this scene, you have – – Ѝυϳ  πȢττχς– ȟ Ὧ Ѝυ Ὧ ςȢςσφὯ. 
 

— ÁÒÃÓÉÎ
Ὧ

Ὧ
ÓÉÎ—  ςφȢςρЈ 
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Ὑ
πȢττχςÃÏÓςφȢςρЈÃÏÓψπȢωρЈ

πȢττχςÃÏÓςφȢςρЈÃÏÓψπȢωρЈ
 πȢτσυ 

Ὑ
πȢττχςÃÏÓψπȢωρЈÃÏÓςφȢςρЈ

πȢττχςÃÏÓψπȢωρЈÃÏÓςφȢςρЈ
 πȢψυτ 

The powers of the reflected rays in the two cases of vertical and horizontal polarizations are then calculated 
as: 

ὖ ȟ ὉὍὙὖ Ὃȟ ςπÌÏÇ
‗

τ“ὶ
ςπÌÏÇȿὙȿ

 ςωȢψψ π ςπÌÏÇ
πȢσ

τ“ ςυȢσρψ
 ςπÌÏÇπȢτσυ σχȢψφÄ"Í 

 

ὖ ȟ ὉὍὙὖ Ὃȟ ςπÌÏÇ
‗

τ“ὶ
ςπÌÏÇȿὙȿ

 ςωȢψψ π ςπÌÏÇ
πȢσ

τ“ ςυȢσρψ
 ςπÌÏÇπȢψυτ σςȢππÄ"Í 

 
The analytical results agree well with the ray tracing simulation results. 

 

 The ray fields are complex-valued. The total ray field at the receiver location is computed as the 

coherent sum of the complex-valued fields of all the individual received rays. 

 
 

2.7 Changing the Polarization of the Transmitter and 
Receiver Antenna 

  
The previous results were obtained using a vertically (Z-directed) polarized half-wave dipole transmitter and 
receiver. Now, you will see what happens if you change the polarization of the transmitter antenna and the 
receiver. Open the property dialog of the Point Radiator Set associated with the transmitter (TXB) from the 
navigation tree. In the section entitled Radiator Type, choose the option "Y" from the drop-down list 
labeled Direction next to the radio button Half-Wave Dipole, which has already been selected (Figure 19). 
Similarly, open the property dialog of the point radiator associated with the receivers (RXB) and change the 
polarization of the receivers to Y-directed horizontal. 

 

http://www.emagtech.com/wiki/index.php/File:Attention_icon.png
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Figure 19. Changing the polarization of the transmitter antenna in the point radiator set dialog associated 
with the transmitter (TXB) and receivers (RXB). 

 

Run a single-frequency SBR analysis of your scene and visualize the received power coverage map. You 
will see from Figure 20 that the pattern of the map has changed with respect to the previous case of vertical 
polarization. 
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Figure 20. The top view of the received power coverage map of the receiver set. 

 

Now, open the property dialog of your receiver set once again and select the receiver No. 1296 of the array 
(RX1_1296). The computed Total Received Powers of the direct and ground-reflected rays in this case 
are reported as -30.402dBm and -31.788dBm, respectively, the Data Ray property dialog (Figure 21). 

 

 

Figure 21. Viewing the properties of individual rays in the case of a horizontally polarized dipole 
transmitter. 
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The table below summarizes the important properties of the two rays: 

 

 

 

 

 

 

 

 

Next, keep the polarization of the transmitter to the Y-directed horizontal and change the polarization of the 
receivers to Z-directed vertical (cross-pol) and run a new SBR analysis. Figure 22 shows the top view of 
the received power coverage map of the receiver set. 

 

 

Figure 22. The top view of the received power coverage map of the receiver set. 

 

2.8 Changing the Transmitter Height 
 
Earlier you saw that the Z-coordinate of the transmitter's base point (TXP) was set equal to "tx_h" by the 
wizard. Open the Variables dialog and change the value of “tx_h” from 2 to 10 (see Figures 23-25). 

 Direct Ray Ground-Reflected Ray 

Delay 83.333 ns 84.399 ns 

Theta Angle of Arrival 90° 80.91° 

Phi Angle of Arrival 0 0 

Ray Field Strength -10.178 dBV/m -11.565dBV/m 

Ray Power -30.402 dBm -31.788dBm 
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Figure 23. EM.Terrano's Variables Dialog. 

 

 

Figure 24. The variable edit dialog. 
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Figure 25. Changing the transmitter height to 10m in the Variables dialog. 

 
Close the dialogs to return to the project workspace. You will see the transmitter raise to a height of 10m 
(see Figure 26). Keep in mind that instead of using the variables, you could have simply changed the Z-
coordinate of the point object TXP to 10m from its property dialog. 

 

 

 

 

Figure 26. The geometry of 
the link scene after raising 
the height of the transmitter. 
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Open the Point Radiator Set dialog associated with the transmitter and set the radiators type back to a Z-
directed (vertically polarized) half-wave dipole. Then, run a single-frequency SBR analysis of your scene 
and visualize the received power coverage map (Figure 27). 

 

 

Figure 27. The received power coverage map of the receiver set with the raised vertically polarized 
transmitter. 

 
From the results of this section, you can see that as you increase the height of the transmitter above the 
ground, more interference rings appear in the coverage maps. 

 

2.9 Examining the Brewster Angle 
 
In the case of parallel polarization, at a certain distance between the transmitter and receiver, the ground-
reflected ray may experience the Brewster angle. In that case, the reflected ray theoretically vanishes. The 
Brewster angle is given by: 

— — ÁÒÃÔÁÎ‐ ÁÒÃÔÁÎЍυ  φυȢωЈ 

 
From the ray diagram of the previous section, we can find the following geometrical relationship: 

ÔÁÎ—
Ὀ

Ὤ

Ὀ Ὀ

Ὤ
 

 
From which the distance between the transmitter and the receiver subject to the Brewster angle can be 
found: 

Ὀ Ѝυ Ὤ  ςςȢσφÍ 
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      Ὀ Ὀ Ѝυ Ὤ  τȢτχÍ 

           Ὀ ςςȢσφ τȢτχ ςφȢψσÍ 
 
In this tutorial lesson, the parallel polarization is the case of the vertically polarized (Z-directed) dipole 
transmitter. On the X-axis, the closest receiver to have a horizontal distance Ὀ  26.83m from the 
transmitter is receiver No. 1298: ὼ ὼ  -30 + 26.83 = -3.17m. If you open the ray data dialog of this 
receiver, you will notice that the total electric field intensity and power of the ground-reflected ray in this 
case are extremely small (see Figure 28). 
 

 

Figure 28. The Ray Data dialog of the receiver subject to the Brewster angle. 

 
Also note that you cannot distinguish the receiver with the Brewster angle in the coverage map you got 
earlier. The reason is the coverage map represents the total received power by the receiver. However, the 
power of the direct ray overshadows the power of the ground-reflected ray. EM.Terrano allows you to 
include or exclude certain types of rays in your SBR simulation. To see this, open the Run Simulation dialog, 
and click the Settings next to the engine type drop-down list as shown in Figure 29. The Ray Tracing 
Engine Settings dialog opens up. In the lower section of this dialog, check the box labeled Exclude direct 
(LOS) rays from solution (Figure 30). 
 

 

Figure 29. EM.Terrano's Run Simulation Dialog. 

http://www.emagtech.com/wiki/index.php/EM.Terrano
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Figure 30. EM.Terrano's Ray Tracing Engine Settings dialog. 

 

 
Click the OK button and close the Ray Tracing Engine Settings dialog and run a new SBR simulation. At 
the end of the simulation, visualize the received power coverage map (see Figure 31). This time you will 
see the coverage map corresponding to the ground-reflected rays, with all the direct rays excluded from 
the solution. You can clearly see the dark ring centered at the transmitter with a radius of about 27m. All 
the receivers located on this ring experience the Brewster angle. 
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Figure 31. The received power coverage map of the receiver set corresponding to the ground-reflected 
rays only. 

 


